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บทที่ 1 โปรแกรม SPSS ver.22 และ Microsoft Excel 2013 

 

 ในปฏิบัติการสถิติ ชีววิทยานี  ้จะใช้โปรแกรมวิเคราะห์ทางสถิติ  SPSS ver.22 ส าหรับระบบปฏิบัติการ 
Microsoft Windows ซึง่จฬุาลงกรณ์มหาวิทยาลยั ได้ซือ้สทิธ์ิในการใช้งานในรูปแบบแบง่ปันการใช้งานในมหาวิทยาลยั 
และบางตอนของบทปฏิบตัิการบางบทจะใช้งาน Microsoft Excel ver.2013 บ้าง ดงันัน้ นิสิตจึงควรเข้าใจการใช้งาน
โปรแกรมทัง้สองเป็นอย่างดี ในบทปฏิบตัิการนี ้จะกลา่วถึงการใช้งานโปรแกรมทัง้สองเบือ้งต้นเพื่อให้นิสิตคุ้นเคยกบัเมนู
ค าสัง่ที่จ าเป็นตอ่การปอ้นข้อมลูและการวิเคราะห์ข้อมลูพืน้ฐาน 

 

โปรแกรม SPSS ver.22 

 การเปิดโปรแกรม SPSS ให้เลือ่นไปท่ี Start  แล้วเลอืก IBM SPSS Statistics จากนัน้จึงเลอืก IBM SPSS 

Statistics 22.0 จากรายการ (ภาพท่ี 1 ก) หรือพิมพ์ SPSS ในช่องค้นหา  
(ภาพท่ี 1 ข) 

  

(ก) 

  

(ข) 

ภาพที่ 1 การเปิดโปรแกรม SPSS ด้วยการค้นหาโปรแกรมผา่นเมน ู(ก) และผา่นการพิมพ์ทีช่่องค้นหา (ข) 
 

 เมื่อโปรแกรมเปิดขึน้มา จะมีไดอะล็อค (dialog) ตัง้ค่าเร่ิมต้นเป็นการเปิดไฟล์ที่มีอยู่แล้ว (ภาพที่ 2 ก) แต่หาก
ต้องการพิมพ์ข้อมลูใหม่ ให้เลือก New Dataset (ภาพท่ี 2 ข) เมื่อเลือแล้ว จึงกดที่  อนึ่ง หากไมต้่องการให้ไดอะลอ็ค
นีเ้ปิดขึน้มาทกุครัง้ที่เปิด SPSS ให้กดที่กลอ่งหน้าข้อความ   
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(ก) 

 
(ข) 

ภาพที่ 2 Dialog ให้เลอืกการใช้งานเมื่อเปิด SPSS  
 

 หลงัจากเปิดโปรแกรม SPSS แล้ว จะมีวินโดว์ (window) 2 อนัเปิดขึน้ คือ Data Editor และ Output Viewer 
(ภาพที่ 3) โดย Data Editor จะเป็นวินโดว์ท าหน้าที่ส าหรับก าหนดตวัแปรและปอ้นข้อมลู สว่น Output Viewer จะเป็น
วินโดว์ท าหน้าที่แสดงผลการวิเคราะห์ข้อมูล อนึ่ง ให้สังเกตว่าช่ือของวินโดว์ Data Editor จะระบุช่ือของชุดข้อมูล 
(dataset) เป็นข้อความในเคร่ืองหมายวงเล็บ […] ในภาพที่ 3 นี ้ชุดข้อมลูมีช่ือว่า DataSet1 เมื่อมีการวิเคราะห์ข้อมูล 
ผลต่าง ๆ จะปรากฏหรือบนัทึกไว้ในวินโดว์ Document1 โดยจะระบุว่ามาจากชุดข้อมูลใด (สงัเกตภาพที่ 3 ข ช่องขวา
แสดงช่ือของชดุข้อมลูใหมเ่ป็น DataSet1) 

 

 

(ก) 

 

(ข) 

ภาพที่ 3 วินโดว์เมื่อเปิดโปรแกรม SPSS แบบปอ้นข้อมลูเข้าใหม ่         

 

 วินโดว์ Data Editor จะมีแท็บ 2 แท็บ คือ Data View (ภาพท่ี 4 ก) และ Variable View (ภาพท่ี 4 ข)  
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(ก) 

 

(ข) 

ภาพที่ 4 Data View (ก) และ Variable View (ข) ในวินโดว์ Data Editor  

 

 ใน Data View แต่ละบรรทดัคือระเบียนข้อมลู (record หรือ case) 1 ระเบียนข้อมลู และแต่ละคอลมัน์ คือ ตวั
แปร 1 ตวัแปร สว่นใน Variable View นัน้ แต่ละบรรทดั คือ ตวัแปร 1 ตวัแปร ซึง่จะมีรายละเอียดต่าง ๆ ตามช่ือของหวั
คอลมัน์แตล่ะคอลมัน์ การปอ้นข้อมลูที่ควรปฏิบตัิ คือ ก าหนดตวัแปร แล้วจึงปอ้นคา่ แตอ่าจท าตรงกนัข้ามก็ได้  

ในภาพท่ี 5 เป็นตวัอยา่งการวดัลกัษณะ 8 ลกัษณะ (ภาพที่  5 ก) จากมอสส์ 6 ชนิด (ภาพท่ี 5 ข) จากข้อมลูนี ้มี
จ านวนตวัแปรทัง้สิน 10 ตัวแปร คือ Espèce, Herbarium specimen, 1-8 (จ านวนคอลมัน์ของตารางในภาพที่ 5 ข) 
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ข้อมลูที่มาจากตวัอย่างชิน้เดียวกนั จะอยู่บรรทดัเดียวกนั ในภาพที่ 5 ข จึงมีระเบียนข้อมลู 23 ระเบียนข้อมลูจากตวัอยา่ง 
23 ชิน้  

 

(ก) 

 

(ข) 

ภาพที่ 5 ตวัอยา่งข้อมลู ค าอธิบายตวัแปรที่ 1-8 (ก) และระเบยีนข้อมลู (หรือ case) ของมอสส์ (ข)  
 

 ในการก าหนดตัวแปรนัน้ จะต้องทราบว่าตัวแปรใดเป็นตัวแปรระบุกลุ่ม (Grouping variable หรือ Factor 

variable) ซึง่ปกติผู้วิจยัจะก าหนดขึน้ก่อนท่ีจะด าเนินการทดลองวิจยั อย่างไรก็ตาม ในหลายกรณี อาจจะไมม่ีตวัแปรนีก็้
ได้ หรือตวัแปรระบกุลุม่สามารถทราบจากชุดข้อมลู ในตวัอยา่งดงัภาพที่ 5 นี ้ตัวแปรระบกุลุม่น่าจะเป็น Espèce สว่นตวั
แปรที่เหลืออีก 9 ตวันัน้ มี 1 ตวัแปร (คือ Herbarium specimen) เป็นตวัแปรที่มิได้น าไปวิเคราะห์ แต่เป็นตวัแปรระบุ
ตัวตน ซึ่งในข้อมูลชุดนีใ้ช้ระบุว่าตัวอย่างชิน้ใดที่น ามาวัดลักษณะต่าง ๆ ตัวแปรระบุตัวตนนี ้บางทีเรียก  Hidden 

variable และอีก 8 ตวัแปร เป็นตวัแปรที่วดัคา่ได้และสามารถน าไปวิเคราะห์ข้อมลูทางสถิติตอ่ไปได้ ดงันัน้ ในการก าหนด
ตวัแปร จึงต้องใช้ตวัแปร 10 ตวั ซึง่จะอธิบายการปอ้นรายละเอียดตวัแปร 1 ตวัแปร คือ Espèce ดงันี ้

 ใน Variable View ของ Data Editor ในคอลมัน์ Name จะป้อน species (ภาพที่ 6 ก) ซึ่งช่ือตวัแปรสามารถ
ตัง้ช่ือได้ยาวเพียง 8 อกัษรเท่านัน้ แล้วเลื่อนไปคอลมัน์ Type ซึ่งในคอลมัน์นีค้่าเร่ิมต้นจะเป็น Numeric ให้แล้ว แต่หาก
กดที่  จะมีไดอะลอ็คให้เลอืกประเภทของข้อมลู (ภาพที่ 6 ข) เนื่องจากโมดลูการวิเคราะห์บางโมดลูไมย่อมรับคา่ตวัแปร
ระบกุลุม่ที่เป็นตวัอกัษร (String) ดงันัน้ จึงควรก าหนดประเภทของตวัแปรระบกุลุม่เป็น Numeric เสมอ  
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(ก) 

 

(ข) 

ภาพที่ 6 การปอ้นรายละเอียดตวัแปร Espèce ในคอลมัน์ Name และ Type  
 

ในคอลมัน์ถดัมา Width และ Decimal เป็นการก าหนดจ านวนหลกัและทศนิยมของตวัเลข โดยมีคา่เร่ิมต้นเป็น 
8 และ 2 ตามล าดบั (ภาพที่ 6) ในท่ีนี ้ให้ก าหนดเป็น 4 และ 0 ตามล าดบั (ภาพที่ 7) แสดงวา่ข้อมลูมีคา่ 0-9999 และไม่มี
ทศนิยม ค่าในคอลมัน์ทัง้สองนี ้จะใช้เพื่อแสดงผลใน  Data Editor และ Output Viewer เท่านัน้ หากป้อนข้อมูลที่มี
จ านวนหลกัและทศนิยมมากกว่าที่ก าหนด ก็จะแสดงค่าตามจ านวนหลกัและทศนิยมที่ก าหนดไว้เทา่นัน้ แต่คา่ข้อมลูจริง
ยงัคงอยูแ่ละใช้ในการวเิคราะห์ อนึง่ หากข้อมลูมีจ านวนหลกัและหรือทศนิยมน้อยกวา่คา่เร่ิมต้น อาจไมจ่ าเป็นต้องเปลีย่น
คา่ทัง้สอง แตห่ากมีจ านวนหลกัและหรือทศนิยมมากกวา่ ควรแก้ไขให้สอดคล้องกบัข้อมลูจริง เพื่อการแสดงผลที่ถกูต้อง 

 

 

ภาพที่ 7 การปอ้นรายละเอียดตวัแปร Espèce ในคอลมัน์ Width และ Decimal 
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 ในคอลมัน์ Label เป็นคอลมัน์ที่ใช้ปอ้นข้อความอธิบายช่ือตวัแปร (ภาพท่ี 7) โดยทัว่ไป มกัมีหนว่ยการวดัระบไุว้
ด้วย ความยาวของค าอธิบาย (รวมวรรคตอน) สงูสดุไมเ่กิน 256 ตวัอักษร 

ในคอลมัน์ Values หากตวัแปรนีเ้ป็นตวัแปรระบกุลุม่ สามารถก าหนดค่าและค าอธิบายของค่าที่ก าหนดให้กับ
แตล่ะกลุม่ได้ ในตวัอยา่งข้อมลูนี ้ก าหนดให้ 1 แทน G. torrenticola, 2 แทน P. mutatum, 3 แทน R. riparioides US, 
4 แทน R. riparioides EU, 5 แทน R. alopecuroides และ 6 แทน R. aquaticum ในการก าหนดค่า ให้กดที่  ของ
คอลมัน์ Values (ภาพที่ 8 ก) จะมีไดอะล็อคให้ป้อนค่า (ภาพที่ 8 ข) จากล าดบัข้างต้น ที่หลงั  พิมพ์ 1 และ ที่หลงั

 พิมพ์ G. torrenticola แล้วกด  ท าซ า้จนครบ 6 ค่า เมื่อป้อนครบแล้ว ให้กด  เพื่อกลบัมาที่ Variable 

View (ภาพท่ี 8 ค) 

ในคอลมัน์ Missing เป็นการก าหนดค่าที่ใช้แทนค่าข้อมูลสญูหายของตวัแปร เช่น มีตวัอย่างบางชิน้ในจ านวน

ตัวอย่างทัง้หมดที่ลกัษณะหนึ่งเกิดความเสียหายจนวดัค่าไม่ได้ ดังนัน้ จึงต้องใส่ค่าให้กับตัวแปรของลกัษณะนัน้ใน

ระเบียนข้อมลูของตวัอยา่งชิน้ดงักลา่ว เพื่อท าให้ทราบวา่ไมม่ีข้อมลูเนื่องจากวดัคา่ไมไ่ด้ ซึง่ในการวิเคราะห์ข้อมลู จะไมน่ า

คา่ดงักลา่วไปค านวณแต่อยา่งใด โดยทัว่ไป มกัก าหนดเป็นคา่ติดลบ เช่น -99 -999  ในการระบคุา่เมื่อตวัแปรมีข้อมลูสญู

หาย ให้กด  ในคอลมัน์ Missing ของตวัแปรนัน้ (ภาพท่ี 9 ก) จะมีไดอะลอ็ค (ภาพท่ี 9 ข) ให้ปอ้นคา่แทนค่าข้อมลูที่สญู

หาย ซึ่งค่าเร่ิมต้น คือ No missing values ทัง้นี  ้สามารถป้อนค่าได้ 3 ค่า หรือป้อนค่าเป็นช่วงก็ได้ เนื่องจากตัวแปร 

Espèce ไมม่ีข้อมลูสญูหาย จึงเลอืก No missing values 

ในคอลมัน์ Column เป็นการก าหนดความกว้างของคอลมัน์ตัวแปรนัน้ (ภาพที่ 10 ก) ใน  Data View ของ

วินโดว์ Data Editor หากต้องการเพิ่มความกว้าง กดที่  แตห่ากต้องการลดความกว้าง กดที่  

ในคอลมัน์ Align เป็นการก าหนดการจดัเรียงชิดขอบของข้อมูลในคอลมัน์ตวัแปรนัน้ (ภาพที่ 10 ข) ใน  Data 

View ของวินโดว์ Data Editor ซึ่งมี 3 ตัวเลือก คือ Left Right และ Center ส าหรับค่าตัง้ต้น จะขึน้กับประเภทของ

ข้อมลู หากเป็น Numeric จะเป็น Right แตห่ากเป็น String จะเป็น Left 

ในคอลมัน์ Measure เป็นการก าหนดระดบัการวดัของค่าข้อมลูของตวัแปร (ภาพที่ 10 ค) ซึ่งมี 3 ระดบั (เรียง

จากระดบัสงูไปต ่า) คือ Scale Ordinal และ Nominal หากประเภทข้อมลูเป็น Numeric จะต้องก าหนดว่าระดบัข้อมูล

เป็นระดบัใดจาก 3 ระดบั แตห่ากข้อมลูเป็น String ระดบัข้อมลูจะถกูก าหนดเป็น Nominal แตอ่าจก าหนดเป็น Ordinal 

ได้ 
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(ก) 

 

(ข) 

 

(ค) 

ภาพที่ 8 การปอ้นรายละเอียดตวัแปร Espèce ในคอลมัน์ Values (ก) โดยผา่นไดอะลอ็ค (ข) เมือ่ปิดไดอะลอ็คจะมีคา่
ปรากฏในคอลมัน์ Values (ค) (คา่บางสว่น) 

 

ในคอลมัน์ Role เป็นการก าหนดบทบาทของตวัแปรในการวิเคราะห์ (ภาพท่ี 10 ง) ซึง่มีความจ าเป็นต้องก าหนด

ก่อนที่จะเร่ิมวิเคราะห์ข้อมลู โดยมีบทบาทให้เลอืกก าหนดเป็น  

 Input = Independent variable หรือ predictor คา่นีเ้ป็นคา่เร่ิมต้น บางครัง้ อาจ

หมายถึง Grouping variable หรือ Factor variable  

 Target = dependent variable หรือเป็น outcome 

 Both = เป็นทัง้ Independent variable และ dependent variable 

 None = ไมก่ าหนดบทบาทใด ๆ 

 Partition = ตวัแปรที่ใช้แบง่ case ออกเป็นกลุม่ตวัอยา่งตัง้แต ่2 กลุม่ขึน้ไป 

 Split = ไมใ่ช้กบั IBM SPSS Statistics 22 
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(ก) 

 

(ข) 

ภาพที่ 9 การปอ้นรายละเอียดตวัแปร Espèce ในคอลมัน์ Missing (ก) และก าหนดคา่แทนข้อมลูที่สญูหาย (ข)  

 

 

(ก) 

 

(ข) 

 

(ค) 

 

(ง) 

ภาพที่ 10 การปอ้นรายละเอียดตวัแปร Espèce ในคอลมัน์ Coulmns (ก) Align (ข) Measure (ค) และ Role (ง) 
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ภาพที่ 11 ตวัแปรทัง้หมดจากภาพท่ี 5 ข ท่ีปอ้นรายละเอียดใน Variable View 

 

เมื่อปอ้นรายละเอียดตวัแปรทัง้หมดแล้ว จะได้ Variable View ดงัภาพท่ี 11 และหากปอ้นข้อมลูครบถ้วน จะได้

ชดุข้อมลูใน Data View ดงัภาพที่ 12 ก สงัเกตวา่ตวัแปร species และ tinged มีคา่ 1 2 3 4 5 6 และ 0 1 ตามล าดบั 

หากต้องการให้แสดงคา่ทีแ่ทนคา่ตวัเลขเหลา่นี ้(ภาพที่ 12 ข) ท าได้โดยเลอืก View > Value Labels หรือกดที่  

 

 

(ก) 

ภาพที่ 12 ข้อมลูจากภาพที่ 5 ข เมื่อปอ้นคา่ใน Data View  
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(ข) 

ภาพที่ 12 (ต่อ) ข้อมลูจากภาพที่ 5 ข เมื่อปอ้นคา่ใน Data View เมื่อเลอืก View > Value Labels  
 

 เมื่อปอ้นข้อมลูเสร็จแล้ว ควรบนัทกึลงไฟล์ โดยเลอืกค าสัง่ File > Save จะมีไดอะลอ็คดงัภาพท่ี 13 ก  

 Look in: ให้ระบโุฟลเดอร์ที่จะบนัทกึข้อมลู 

 File name: ให้พิมพ์ช่ือไฟล์ของข้อมลู 

  เลอืกตวัแปรที่ต้องการบนัทกึข้อมลู (ภาพที่ 13 ข) แล้วกด  

 Save as type: ระบรูุปแบบไฟล์ที่ต้องการบนัทกึข้อมลู (ภาพที่ 13 ค) โดยทัว่ไปเป็น *.SAV 

 

(ก) 

ภาพที่ 13 การก าหนดคา่เพื่อบนัทกึข้อมลู  
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(ข) 

 

(ค) 

ภาพที่ 13 (ต่อ) เลอืกตวัแปรที่ต้องการบนัทกึ โดยกดที่  ให้เป็น  ในช่อง Keep และเลอืกรูปแบบไฟล์ที่ต้องการ
บนัทกึ (ค) 
 

 เมื่อก าหนดคา่ตา่ง ๆ แล้ว กดที่  เพื่อบนัทกึข้อมลู 

 ในการวิเคราะห์ข้อมลู จะเลือกวิธีการวิเคราะห์ทางสถิติจากเมน ูและก าหนดตวัแปร รวมถึงค่าสถิติที่ต้องการใน

ไดอะลอ็คตา่ง ๆ ในตวัอยา่งนี ้จะสร้างกราฟแสดงคา่เฉลีย่และคา่เบี่ยงเบนมาตรฐาน จากเมน ูGraph > Legacy Dialogs 

> Error Bar… (ภาพท่ี 14 ก) เลอืกกราฟแบบ Simple และเลอืกตวัแปรและคา่สถิติดงัแสดงในภาพท่ี 14 ข และ ค 
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(ก) 

 

(ข) 

ภาพที่ 14 การสร้างกราฟ Error Bar โดยใช้จากเมนคู าสัง่ (ก) เลอืกแบบของกราฟ (ข)  
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(ค) 

ภาพที่ 14 (ตอ่) ก าหนดคา่ตา่ง ๆ (ค)  

 

 เมื่อก าหนดค่าครบถ้วนแล้ว กด   วินโดว์ Output Viewer จะแสดงผลกราฟ ดังภาพที่ 15 สงัเกตว่าใน

วินโดว์นี ้จะแบง่เป็น 2 ช่อง คือ 

 ช่องซ้ายจะแสดงรายการการวิเคราะห์แยกตามค าสัง่การวิเคราะห์ ในกรณีนี ้มีเพียงค าสัง่เดียว Graph และ

ในหวัข้อ Graph นี ้จะมีรายการยอ่ยอกีสามรายการ คือ Tittle, Notes และ Error Bar of lcl by species 

สงัเกตว่า จะมีสญัญลักษณ์ – ที่หน้า Graph และช่องทางขวามีผลการวิเคราะห์จากค าสัง่ Graph คือ 

กราฟนัน้เอง (ภาพที่ 15 ก) หากกดที่สญัลกัษณ์นี ้ จะเป็นการซ่อนรายการย่อยและผลการวิเคราะห์ของ 

Graph และมีสญัลกัษณ์ + ปรากฏแทนท่ี (ภาพท่ี 15 ข) 

 ช่องขวาจะแสดงผลการวิเคราะห์ของแต่ละค าสัง่ ซึง่มีรายละเอียดแตกต่างกนัขึน้กบัค าสัง่ที่ท างาน สงัเกต

วา่เมื่อเลือกรายการย่อยในช่องซ้าย จะมีลกูศรสีแดงที่รายการยอ่ยที่เลือกในช่องซ้าย ในขณะที่ในช่องขวา 

จะมีกรอบล้อมรอบผลการวิเคราะห์ที่ตรงกบัรายการยอ่ยนัน้และลกูศรสีแดงก ากบัด้วย (ภาพท่ี 15 ก) 
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(ก) 

 

(ข) 

ภาพที่ 15 วินโดว์ Output Viewer แสดงผลการสร้างกราฟตามค าสัง่ Graph ในภาพท่ี 14  

 

 หากต้องการหาคา่สถิติพรรณนาแยกตาม species สามารถท าได้จากเมนใูนวินโดว์ Output Viewer โดยเลอืก

ค าสัง่ Analyze > Descriptive… > Explore… (ภาพท่ี 16 ก) แล้วก าหนดตวัแปรและคา่สถิติตามภาพที่ 16 ข แล้วกด 
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(ก) 

 

(ข) 

ภาพที่ 16 การวเิคราะห์สถิติพรรณนาด้วยค าสัง่ Explore (ก) และก าหนดตวัแปรและคา่สถิติ (ข)  

 

 ผลการวิเคราะห์แสดงในภาพท่ี 17 ในผลการวเิคราะห์มีค าเตือน (warnings) เกิดขึน้ เนื่องจากชดุข้อมลูนี ้ไม่

ตรงกบัเง่ือนไขการวิเคราะห์ด้วยค าสัง่ Explore อยา่งไรก็ตาม แม้ค าเตือนนีไ้มใ่ช่ข้อผิดพลาด (error) และยงัสามารถ

วิเคราะห์ข้อมลูตอ่ไปได้ แตค่วรตรวจสอบค าเตือนวา่สามารถแก้ไขได้หรือไม ่หรือผลการวิเคราะห์นีจ้ะนา่เช่ือถือหรือไม ่ 
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(ก) 

 

(ข) 

ภาพที่ 17 ผลการวิเคราะห์สถิตพิรรณนาด้วยค าสัง่ Explore แสดงค าเตอืน (Warnings) (ก) การแจกแจงข้อมลู
แยกตามตวัแปรและ species (ข) 
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(ค) 

ภาพที่ 17 (ต่อ) สถิติพรรณนาแยกตามตวัแปรและ species (ค) ซึง่ในภาพแสดงเพียงตวัแปรเดยีว ใน 2 species  

 

จากภาพที่ 17 จะเห็นได้วา่ค าสัง่ Explore มีรายการผลการวิเคราะห์เกิดขึน้มากกวา่ค าสัง่ Graph อีกทัง้มี

รายการแยกยอ่ยในล าดบัท่ีมากกวา่ด้วย (กลา่วคือ 2 ล าดบัใน Explore เทียบกบั 1 ล าดบัใน Graph) โดยเป็นรายการ 

Case processing Summary (ภาพท่ี 17 ข) ซึง่บรรยายจ านวนระเบียนข้อมลูแยกตาม species และ Descriptive 

(ภาพท่ี 17 ค) ซึง่เป็นผลการวิเคราะห์สถิติพรรณนาแยกตาม species ในแตล่ะตวัแปร 

ข้อดีของ Output Viewer คือ สามารถบนัทกึผลการวิเคราะห์ไว้ได้ และสามารถเรียกผลการวเิคราะห์กลบัมาดู

ได้โดยไมต้่องวิเคราะห์ข้อมลูใหมแ่ตอ่ยา่งใด เพียงแตผู่้วิจยัต้องจดัท ารายการให้สามารถเข้าใจได้งา่ย ไมส่บัสนหรือ

ซบัซ้อนจนเกินไป 

เมื่อต้องการเลกิใช้งาน SPSS ให้เลอืก File > Exit หากยงัไมไ่ด้บนัทกึข้อมลู จะมีไดอะลอ็คเตือนเพือ่ให้บนัทกึ

ข้อมลูก่อนปิดโปรแกรม 

 

  



18 
 

โปรแกรม Microsoft Excel 2013 

 Microsoft Excel 2013 เป็นโปรแกรมหนึ่งใน Microsoft Office 2013 และเป็นโปรแกรมที่ใช้ในการเก็บ
ข้อมลู การค านวณและการวิเคราะห์ทางสถิติ รวมถึงการสร้างกราฟเพื่อน าเสนอผลการวิเคราะห์ต่าง ๆ ในบทปฏิบตัิการนี ้
จะเป็นการใช้โปรแกรมเบือ้งต้นเพื่อปอ้นข้อมลูและรู้จกัวิธีการปอ้นสตูรส าหรับค านวณคา่สถิติบางคา่ 

 ในระบบปฏิบัติการ Windows การเปิดโปรแกรม Excel ท าได้โดยเลือก  > Microsoft Office 2013 > 

Excel 2013 (ภาพที่ 18 ก) หรือโดยกดแป้น winkey หรือ แล้วพิมพ์ Excel ในช่องค้นหา แล้วเลือก Excel 2013 

(ภาพท่ี 18 ข) 

 

(ก) 

 

(ข) 

ภาพที่ 18 การเปิดโปรแกรม Excel 2013 โดยเลอืกจากเมน ู(ก) หรือค้นหาไฟล์ (ข) 
 

 เมื่อ Excel เปิดขึน้มา จะมีไดอะล็อคให้เลอืกแบบของแฟ้มข้อมลู (ภาพท่ี 19 ก) ให้เลือก Blank workbook จะ
ได้ workbook ดงัภาพท่ี 19 ข ใน workbook จะประกอบด้วยตารางโดยแถวจะก ากบัด้วยตวัเลข และคอลมัน์ก ากบัด้วย
ตวัอกัษรภาษาองักฤษ ต าแหนง่ของข้อมลูในตาราง เรียกวา่ “เซลล์” และ จะอ้างถึงโดยใช้รูปแบบ อกัษรก ากบัคอลมัน์ตาม
ด้วยตวัเลขก ากบัแถว ในภาพที่ 22 ท่ีคอลมัน์ A และที่แถว 1 จะมีแถบสเีข้มกวา่คอลมัน์หรือแถวอื่น นัน้เพราะวา่เซลล์ A1 
คือ active cell หรือเซลล์ที่เลอืกไว้ โดยจะมีกรอบสดี าเข้มกวา่เซลล์อื่น ๆ ซึง่เป็นเส้นบางกวา่มาก การเปลีย่น active cell 
ท าได้โดยใช้คีย์  เพื่อเลื่อนไปยงัเซลล์ด้ายขวา ซ้าย บน และ ลา่ง ต่างล าดบั สงัเกตวา่เซลล์ที่เป็น  active cell 
ใน Name Box (อยูเ่หนือหวัคอลมัน์ A) จะเปลีย่นไปด้วย อีกวิธีหนึง่ คือ เลือ่น  (โดยเลือ่นเม้าส์) ไปยงัเซลล์ที่ต้องการ 
แล้วกดแปน้ซ้ายของเม้าส์ 

 การป้อนข้อมลูท าได้โดยเลือกเซลล์ที่ต้องการป้อนข้อมลู แล้วพิมพ์ข้อมลู เมื่อพิมพ์เสร็จ กดคีย์ Enter จะท าให้ 

active cell เลื่อนไปเป็นเซลล์ที่อยู่ถัดลงไป (แต่สามารถเปลี่ยนทิศทางการเลื่อนได้) ให้ป้อนข้อมูลในแถวที่ 1 ตัง้แต่
คอลมัน์ A เป็นต้นไป โดยใช้ข้อมลูจากหวัตารางในภาพที่ 5 เมื่อป้อนข้อมลูแล้ว จะได้ workbook ดงัภาพที่ 20 ก สงัเกต
ว่าข้อความในเซลล์ B1 ถึง J1 มีความยาวเกินกว่าความกว้างของแต่ละคอลมัน์ ข้อความบางส่วนจึงถูกบังไว้ แต่หาก
คอลมัน์ถดัไป (เช่น K1) ไมม่ีข้อมลูใด ๆ ข้อความในคอลมัน์ก่อนหน้า (เช่น J1) จะแสดงให้เห็นได้ 
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(ก) 

 

(ข) 

ภาพที่ 19 ตวัเลอืกแฟม้ข้อมลูแบบตา่ง ๆ เมื่อ Excel 2013 เปิดใช้งาน (ก) และ blank workbook (ข)  
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(ก) 

 

(ข) 

 

(ค) 

 

(ง) 

 

(จ) 

ภาพที่ 20 ข้อมลูในแตล่ะเซลล์ (ก) เพิ่มขนาดคอลมัน์ (ข-ค) และก าหนดให้ข้อความขึน้บรรทดัใหม ่(ง-จ) 
 

 หากต้องแสดงข้อความทัง้หมด สามารถท าได้ 2 วิธี โดยวิธีแรกเป็นการเพิ่มความกว้างของคอลมัน์ ซึง่ท าได้ด้วย
การเลือ่น  ไปวางไว้ระหวา่งคอลมัน์ B กบั C (ให้วางเหนือแถว 1) จนเปลีย่นไปเป็น (ภาพท่ี 20 ข) แล้วกดแปน้ซ้าย
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ของเม้าส์ 2 ครัง้ติดกนั จะท าให้คอลมัน์ B เพิ่มความกว้างในเท่ากบัความยาวข้อความในเซลล์ B1 โดยอตัโนมตัิ (ภาพที่ 
20 ค) อนึง่ หากต้องการเพิ่มความกว้างของคอลมัน์เอง ให้ท าคล้ายกบัวิธีการท่ีกลา่วมา คือ เมื่อ  เปลีย่นเป็น  แล้ว 
ให้กดแปน้ซ้ายของเม้าส์ค้างไว้ แล้วเลือ่นเม้าส์จนกระทัง่ได้ความกว้างของคอลมัน์ตามที่ต้องการ จึงเลกิกดแปน้เม้าส์ 

 สว่นวิธีที่สอง คือ ให้ข้อความขึน้บรรทดัใหม่โดยไม่ปรับความกว้างของคอลมัน์ วิธีท าคือเลือกเซลล์  C1 ถึง J1 

โดยเลือ่น  ไปวางที่เซลล์ C1 กดแปน้ซ้ายของเม้าส์ค้างไว้ แล้วลากเม้าส์ไปทางขวาจนถึงเซลล์ J1 สงัเกตวา่มีกรอบเข้ม
ล้อมรอบจาก C1 ถึง J1 และมีแถบสีระบายด้วย (เซลล์ C1 จะโปร่ง) (ภาพท่ี 20 ง) จากนัน้ กดที่ ในริบบอน 

Home | Alignment ข้อความจะขึน้บรรทดัใหม่ (ภาพที่ 20 จ) ซึ่งอาจไม่ถูกต้องสวยงามนกั แต่สามารถปรับแก้ไขโดย
เพิ่มความกว้างของคอลมัน์ ดงัที่กลา่วมาในยอ่หน้าที่ผา่นมา 

 การป้อนข้อมลู (ใช้ข้อมลูที่ก าหนดให้ในภาพที่ 5) จะมีทัง้ที่เป็นข้อความและตวัเลข สงัเกตว่าเซลล์ที่มีข้อความ 

ข้อความจะจดัเรียงชิดซ้าย แต่หากเซลล์มีตวัเลข ตวัเลขจะจดัเรียงชิดขวา การแก้ไขข้อมลูหากพิมพ์ผิด ให้เลือ่น  ไปยงั
ต าแหนง่ที่ต้องการแก้ไข แล้วกดแปน้ซ้ายของเม้าส์ 2 ครัง้ติดกนั จะมีสามารถแก้ไขข้อมลูได้ (ใช้คีย์ลกูศรหรือ Backspace 

หรือ Del เพื่อเลื่อน cursor หรือลบข้อความ) หรืออาจเลือกเซลล์ที่ต้องการแก้ไขก่อน แล้วเลื่อน  ไปที่ Formula bar 

 จนเปลี่ยนเป็น I-beam จึงกดแป้นซ้ายของเม้าส์ แล้วแก้ไขข้อความที่ Formula 

bar 

ในข้อมูลที่ก าหนดให้ จะมีค่าที่ซ า้ ๆ กัน เช่น ช่ือชนิด ห รือค่าในตัวแปร Gametophyte tinged with a 

golden/brown colour จึงควรใช้วิธีการคดัลอกจากเซลล์หนึ่งไปยงัอีกเซลล์หนึ่งแทนการพิมพ์ โดยสามารถท าได้ดงันี ้
จากภาพที่ 21 ก ได้ป้อนข้อมูล 3 ระเบียนข้อมูล ระเบียนข้อมูลถัดไปอีก 15 ระเบียนข้อมูล เป็นข้อมูลจากชนิด R. 

riparioides US การคัดลอกช่ือชนิดโดยใช้ Fill handle ท าได้ด้วยการเลือกเซลล์ A4 แล้วเลื่อน ไปวางที่  ซึ่งอยู่
มมุซ้ายของเซลล์ A4 จนเปลี่ยนเป็น  จากนัน้กดแป้นซ้ายของเม้าส์ค้างไว้ แล้วลากเม้าส์ลงจนถึงเซลล์ A19 จึงเลิกกด
แปน้เม้าส์ ได้เซลล์ A5 ถึง A19 มีช่ือชนิด R. riparioides US (ภาพท่ี 21 ข)  

วิธีการคดัลอกอีกวิธี คือ เลอืกเซลล์ที่ต้องการคดัลอก (ให้เลอืกเซลล์ C4) จากนัน้ กดที่  ในริบบอน Home | 

Clipboard สงัเกตว่าเซลล์ C4 มีกรอบเส้นประล้อมรอบแทน (ภาพที่ 22 ก) จากนัน้เลือกเชลล์ C5 ถึง C19 แล้วกด  

ในริบบอน Home | Clipboard เพื่อคดัลอก (ภาพที่ 22 ข) วิธีการคดัคอก Copy-Paste นี ้มีข้อดีคือ สามารถใช้ได้กับ
การคดัลอกเซลล์ที่อยู่ห่างจากเซลล์ที่จะคดัลอก หรือช่วงเซลล์ที่ยาวมาก ไม่สะดวกต่อการใช้  Fill Handle หรือต้องการ
คดัลอกไปหลายเซลล์ที่ไมต่ิดกนั โดยคดัลอกที่ละเซลล์หรือช่วงของเซลล์ 
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(ก
) 

 

(ข) 

ภาพที่ 21 การคดัลอกคา่โดยใช้ Fill handle (ก) และเมื่อคดัลอกแล้ว (ข) 
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(ก
) 

 

(ข) 

ภาพที่ 22 การคดัลอกโดยใช้ Copy (ก) และ เมื่อใช้ Paste (ข)  

 

 เมื่อปอ้นข้อมลูเสร็จ (ภาพท่ี 23) จะมีจ านวน 59 ระเบียนข้อมลู ครอบคลมุเซลล์ A1 ถึง J60 (หรือ A1:J60) เมื่อ
ต้องการเลื่อนลงดขู้อมลูด้านลา่ง เซลล์ด้านบนจะหายไป จนอาจจะไม่เห็นแถวที่เป็น “หวัตาราง” ซึ่งมีรายละเอียดอธิบาย
คา่ในแตล่ะคอลมัน์  หากต้องการตรึงแถวที่เป็นหวัตาราง ให้เลอืกเซลล์ในคอลมัน์เดียวกบัเซลล์แรกของหวัตาราง แตอ่ยูใ่น
แถวที่ถัดลงมาจากแถวที่เป็นหัวตาราง ในภาพที่ 23 หัวตารางของข้อมูลอยู่ในเซลล์ A1:J1 ดังนัน้ ให้เลือกเซลล์ A2 

จากนัน้ กดที่   ในริบบอน View | Window > Freeze Panes 
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ภาพท่ี 23 workbook ที่ปอ้นข้อมลูครบถ้วน (แสดงบางสว่น) 
 

 การค านวณหาค่าทางสถิติบางค่าสามารถท าได้ใน Excel ในบทนีจ้ะยกตวัอย่างเพียง 4 ค่า เพื่อให้เข้าใจถึง
วิธีการป้อนสตูรทางคณิตศาสตร์และสตูรค านวณอื่น ๆ ข้อแตกต่างที่ส าคญัในการป้อนสูตรเพื่อการค านวณ คือ จะต้อง
พิมพ์ = ก่อนเสมอ แตก่ารปอ้นข้อความหรือตวัเลข สามารถพิมพ์ตวัอกัษรหรือตวัเลขได้โดยไมต้่องพิมพ์ = ก่อน 

 ในขัน้แรก ให้เลื่อนไปยงัเซลล์ C62 แล้วพิมพ์ข้อความลงในเซลล์ C62:C65 ดงัภาพที่ 23 ซึ่งหมายถึงค่าต ่าสดุ 
คา่มากสดุ คา่พิสยั และคา่เฉลีย่ การปอ้นสตูร จะอธิบายเป็นขัน้ตอนดงันี ้

 เลอืกเซลล์ D62 แล้วพิมพ์ =min(  

 เลือ่น  ไปท่ีเซลล์ D60 กดแปน้ซ้ายของเม้าส์ สงัเกตวา่ทีเ่ซลล์ D62 จะเปลีย่นเป็น =min(C60 และ

ที่เซลล์ D60 จะมีกรอบเส้นประเกิดขึน้ (ภาพท่ี 24 ก) 

 เลือ่น  ไปวางที่  ที่มมุซ้ายบนหรือมมุขวาบนของกรอบเส้นประของเซลล์ D60 จนเปลีย่นเป็น  

 กดแปน้ซ้ายเม้าส์ค้างไว้ แล้วลากเม้าส์ขึน้ไปถงึเซลล์ D2 จึงเลกิกดแปน้เม้าส์ สงัเกตที่ Formula bar 

จะเปลีย่นเป็น =min(D2:D60 และเซลล์ D2 ถึง D60 มีกรอบทบึล้อมรอบและมีแถบสรีะบาย (จะเห็น

เพียงเซลล์ D2 ถึง D20 แตเ่ซลล์ถดัลงมาไมเ่ห็น) (ภาพที่ 24 ข) 

 พิมพ์ ) แล้วกด  สงัเกตวา่คา่ในเซลล์ D62 จะแสดงคา่ที่ต า่สดุของข้อมลู D2:D60 (ภาพท่ี 24 

ค)  



25 
 

 

(ก) 

 

(ข) 

 

(ค) 

ภาพท่ี 24 การปอ้นสตูรค านวณและก าหนดเซลล์เร่ิมต้น (ก) ก าหนดเซลล์สดุท้าย (ข) และผลการค านวณ (ค)  
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การค านวณคา่ที่เหลอื ท าได้ดงันี ้ 

 เซลล์ D63 พิมพ์ =max(D2:D60) แล้วกด    

 เซลล์ D64 พิมพ์ = แล้วเลอืกเซลล์ D63 พิมพ์ – แล้วเลอืกเซลล์ D62 แล้วกด  

 เซลล์ D65 พิมพ์ =average(D2:D60) แล้วกด    

 ได้ผลการค านวณดงัภาพท่ี 25 ก 

การค านวณหาคา่ทัง้สีส่ าหรับตวัแปรที่เหลอือีก 6 ตวัแปรในเซลล์ E62:J66 ท าได้โดยคดัลอกสตูรการค านวณ

จากเซลล์ D62:D66 ดงันี ้

 เลอืกเซลล์ที่ต้องการคดัลอกสตูร ซึง่คือ D62:D66 แล้วกด  (ภาพที่ 25 ข) 

 เลอืกเซลล์ที่จะค านวณคา่จากสตูรที่คดัลอกมา คือ E62:J66 แล้วกด  (ภาพท่ี 25 ค) 

 หากเลอืกดสูตูรการค านวณในเซลล์ใดเซลล์หนึง่ใน E62:J66 จะเห็นวา่ในแถวเดยีวกนั จะเป็นสตูร

เดียวกนั แตต่า่งคอลมัน์ เช่น F63 กบั G63 จะใช้ข้อมลูค านวณคา่ตา่งกนั (ภาพท่ี 25 ง)  

 

 

(ก) 

 

(ข) 

 

(ค) 

 

 

(ง) 

ภาพที่ 25 ผลการค านวณค่าในเซลล์ D63:D66 (ก) การเลือกเซลล์ที่จะคดัลอกสตูร (ข) การคดัลอกสตูร (ค) และ
เซลล์ที่มีสตูรเดียวกนัแตใ่ช้คา่ตวัแปรตา่งกนั (ง) 
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 ในการคดัลอกสตูรจากเซลล์ไปยงัอีกเซลล์หนึ่งนัน้ Excel จะใช้การอ้างอิงเซลล์โดยต าแหน่งสมัพทัธ์ (relative 

reference) ระหว่างเซลล์ที่มีสตูรค านวณกับเซลล์ที่เก็บข้อมูล ในตวัอย่างข้างต้น เซลล์ D62 มีสตูรการค านวณหาค่า
ต ่าสดุ โดยใช้ข้อมลูในเซลล์ D2:D60 ดงันัน้ เซลล์ที่มีสตูรค านวณและเก็บผลการค านวณ อยู่ห่างข้อมลูเร่ิมต้น (คือ D2) 
60 แถวเหนือขึน้ไป 0 คอลมัน์ และอยูห่า่งจากเซลล์ข้อมลูสดุท้าย (คือ D60) 2 แถวเหนือขึน้ไป 0 คอลมัน์ เมื่อคดัลอกสตูร
จากเซลล์ D62 ไปยงัเซลล์ G62 จึงน าคา่จาก G2 ถึง G60 มาค านวณหาคา่ต ่าสดุ แตห่ากน าสตูรจาก D62 ไปคดัลอกให้
เซลล์ G63 แทน การค านวณจะน าข้อมลูจากเซลล์ G3 ถึง G61 มาค านวณแทน ซึง่จะให้ผลค านวณผิดเพราะเซลล์ G61 
ไมม่ีข้อมลู แตเ่ซลล์ที่มีข้อมลู (คือ G2) ไมถ่กูน ามาร่วมค านวณ 

 อีกตวัอย่างหนึ่ง คือสตูรในเซลล์ D64 ซึ่งเป็นผลต่างระหว่างค่าสงูสดุกับค่าต ่าสุด คือ D63 – D62 ในกรณีนี ้
เซลล์ที่มีสตูรและเก็บผลการค านวณอยู่จากเซลล์แรกในสตูร 1 แถวเหนือขึน้ไป 0 คอลมัน์ และอยู่ห่างจากเซลล์ที่สองใน
สตูร 2 แถวเหนือขึน้ไป 0 คอลมัน์ หากคดัลอกสตูรจาก D64 ไปยงั G64 แล้ว ผลการค านวณจะเป็นผลของ G63-62 แต่
หากคดัลอกไปใสเ่ซลล์ G65 แทน จะได้คา่ที่ผิด 

 การบันทึกข้อมูล ให้เลือก File > Save > Computer หากต้องการบันทึกไฟล์ใน  C: หรือ USB drive หาก
ต้องการปิดโปรแกรม ให้กดที่  ที่มมุซ้ายบน 

 


